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Ex No: 1 Date:  

a) Starting a program, running a program 
b) Running multiple programs and switching between windows 
c) Running a program from explorer 

 
AIM : Starting a program, running a program 
Procedure: 

Step 1 : Click Start  Button 

Step 2: Type the Application Name in Search Box. Excel  

Step 3: Right-Click on the Excel Application and Click on Open file 

location.  

 

Step 4: Click on the Microsoft Excel 2010 icon then Press Keys  + (Copy). 

Step 5 : Press Keys Start   +  

Step 6 : In the box type  shell:startup  OK  
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Step 7: Open Startup folder Press Keys  +  (Paste.) 

Step 8: Automatically run the Excel program after Restarting Computer. 

Result:  

The program was Executed Successfully and output is verified. 

Output:   
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AIM : Running multiple programs and switching between windows    

Procedure: 

Step 1 : Press Keys Start    +  

Step 2 : In the box type Mspaint   OK and Calc OK.(Open More Application) 

 

Step 3 : Press key  + . Now you can easily switch from one application to  another 

application. 

Step 4 : Press and hold +  A small box reveals all opened programs. 

Step 5 : Release the  key but keep  pressed down; press  until you reach the program 
you want. 

Step 6 : Each time you press , you cycle through the icons representing open programs. 

Step 7 : Release the key. Windows 10 switches to whichever program is selected. 

Step 8 : To switch back to the last program that was active, simply press +  That 

program becomes the active program once again. 

Result :  

The program was Executed Successfully and output is verified. 
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Output:   
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AIM : Running a program from explorer 

Procedure: 

Step 1: Press Keys Start   + (Open Run window)  

Step 2:  In the box type explorer    OK  

 

Step 3:  Press Key (Start)       + My Computer - explorer will be Open. 

Result:  

The program was Executed Successfully and output is verified. 

Output:   
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Ex No: 2 Date: 

a) Customizing the Task bar, Making the taskbar wider 
b) Controlling the size of start menu options 
c) Adding a program to the start menu 

 
AIM : Customizing the Task bar, Making the taskbar wider 
Procedure: 

Step 1: Right-click any empty area of the taskbar and click “Taskbar Settings” to change taskbar 

settings. 

 

 
Change Customizing the Task bar 
 

Step 2: Lock the taskbar  OFF / ON 

Step 3: Automatically hide the taskbar in desktop mode OFF / ON 

Step 4: Use small taskbar buttons  OFF / ON 

Step 5: Place your mouse at the top edge of the taskbar and drag to resize it. 

Making the taskbar wider 
 
Step 6: Taskbar location on Screen Bottom or Left or Top or Right  
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Result:  

The program was Executed Successfully and output is verified. 

Output:   

Change Task bar Size & location on right side 
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Aim: Controlling the size of start menu options 

Procedure: 

Step 1: Press Keys Start  Button . 

Step 2: Select the top or side border, and then drag to your desired size. 

Step 3: Right-click any empty area of the taskbar and click “Taskbar Settings” to change taskbar 

settings  Personalization   Start, and then turn on Use Start full screen. 

 

Step 4: Show app list in Start menu ON/ OFF 

Step 5: Show recently added apps ON/ OFF 

Step 6: Show most used apps ON/ OFF 

Step 7: Show suggestions occasionally in Start ON/ OFF 

Step 8: Use Start full screen ON/ OFF 

Step 9: Show recently opened items in Jump Lists on Start or the taskbar and File Explorer Quick      
Access ON/ OFF 

Result:  

The program was Executed Successfully and output is verified.  
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Output:  

Start Menu full screen. 
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AIM : Adding a program to the start menu 

Procedure: 

Step 1: Right-Click any Shortcut Icon on the Desktop  

 

Step 2: Select on pop Menu Pin to Start. 

Step 3: Click Start  Button 

Step 4: See Now Shortcut Icon add on to the start menu 

Step 5: If remove the Icon from Start Menu Right-Click any Shortcut Icon on the start menu. 

Step 6:  Select on pop Menu Unpin from Start. 

Result:  

The program was Executed Successfully and output is verified. 
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Output:  
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Ex No: 3 Date:  

a) Recycle bin, restoring the deleted files 
b) Arranging icons on the Desktop 
c) Creating Shortcuts. Adding a program shortcut in the Desktop 

 
AIM: Recycle bin, restoring the deleted files 

Procedure: 

Deleted files or folders. 

Step 1: Select file the files or folders you want to delete  

Step 2: Press Delete Key and Click Yes.  

Step 3: The files or folders Move to Recycle Bin. 

Step 4: If need Permanent Deleted then Press Shift + Delete Key + and Click Yes 

Note : After Recover Not Possible. 

Restoring files or folders.  

Step 1: Open the Recycle Bin by double-clicking on its icon.  

Step 2: Locate the items that you want to recover. 

Step 3: Check the box next to the files or folders you want to retrieve. 

Step 4: Right-click and select restore to recover the items to their original locations. 

Step 5: Select restore all items to restore everything in your recycle bin. 

Result:  

The program was Executed Successfully and output is verified. 
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Output:  

 

Empty Recycle Bin – All File or Folder Move Source Location 

 

Delete – All File or Folder Deleted to Permanent 
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AIM : Arranging icons on the Desktop 

Procedure: 

Auto Arrange Icons 

Step 1: Press Click Start   + or navigate to the Windows desktop. 

Step 2: Right-click a blank area on the desktop, Select View 

Step 3: View  Auto arrange icons  

 

Sort by Arrange Icons 

Step 4: Right-click a blank area on the desktop, Select Sort by 

Step 5: Arrange icons by Name, Type, Size or Date modified and then click Arrange Icons.  

Step 6: Auto Arrange want to arrange the icons on your own, click Auto Arrange to remove the check 

mark. 
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Result:  

The program was Executed Successfully and output is verified. 

Output:  

Right-click a blank area on the desktop, Select Sort by Arrange icons by Name, Type, Size or Date 

modified and then click Arrange Icons.  
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AIM : Creating Shortcuts. Adding a program shortcut in the Desktop 

Procedure: 

Step  1: Press Click Start   Button.   

Step 2: Browse to the Office program for which you want to create a desktop shortcut. 

Step 3: Left-click the name of the program, and drag it onto your desktop. 

Step 4: Shortcut for the program appears on your desktop 

Step 5:  Right-click the program name or File or Folder and then click Send To  Desktop  
(Create shortcut). 

Step 6: A shortcut for the program appears on your desktop. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  
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Ex No: 4 Date:  

a) Creating and removing folders, renaming folders and files 
b) Expanding and collapsing a folder 
c) Sorting a folder 

 
AIM : Creating and removing folders, renaming folders and files 

Procedure: 

Creating New Folder  

Step 1: The fastest way to create a new folder in Windows is with the 

+ + Ctrl+Shift+N shortcut. 

Step 2: Right-click on a blank space in the folder location.  

Step 3: Select New  Folder from the contextual menu. Windows will create the new folder at your 

current location. 

 

Step 4: Enter your desired folder name to replace "New folder" and hit Enter. 

Removing Files or folders 

Step 1: Select file the files or folders you want to delete  

Step 2: Press Delete Key and Click Yes.  

Step 3: The files or folders Move to Recycle Bin. 
Step 4: If need Permanent Deleted then Press Shift + Delete Key + and Click Yes.   

Note : After Recover Not Possible. 
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Renaming Folders and Files 

Step 1: Press Click Start   +  Button.   

Step 2: Go to the location where stores your file or folder.  

Step 3: Right click the name of the file or folder you wish to rename. 

 

Step 4: Click Rename (on the menu that opens up).  

Step 5: The fastest way to rename a folder or File Click File and Press F2 Key  

Step 6: Type a new name for the file or folder and press Enter Key. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

 

 

 



COA – Computer on Office Automation - Practical Guide  20 
AIM : Expanding and collapsing a folder 

Procedure: 

Step 1: Press Click Start   +  Button.   

 

Step 2: View Navigation Pane  Show all folders (Click) 

 

Step 3: Click the > (plus symbol) in the folder tree to expand a folder. 

Step 4: You can also double-click a parent folder in the left or right pane to expand it. 

Step 5: Click the V (minus symbol) in the folder tree to collapse a folder. 
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Result:  

The program was Executed Successfully and output is verified. 

Output: 

Expand One Level  

Expand Two Levels  

Expand Three Levels  

Expand All Levels  

Collapse All 
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AIM : Sorting a folder 

Procedure: 

Step 1: Press Click Start    +  Button.   

Sort by Arrange folder 

Step 2: Right-click a blank area on the file Explore, Select Sort by 

Step 3: Select an option, such as name, Date, Size, Type, Date modified, and Dimensions. 

Step 4: The available options vary depending on the selected folder type. 

Ascending. Select to sort items in ascending order A-Z. 

Descending. Select to sort items in descending order Z-A. 

 

Group by Arrange folder 

  



w w w . c c e i n d i a . i n   23 
Step 1: Right-click a blank area on the file Explore, Select Group by 

Step 2: Select an option, such as Name, Date, Size, Type, Date modified. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

The File Explore, Select Sort by Arrange icons by Name, Type, Size or Date modified click Arrange 

File and Folder. (Start    +   View Sort  by) 
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Ex No: 5 Date:  

a) Displaying the properties for a file or folder 
b) Using cut and paste operations to move a file 
c) Using copy and paste operations to copy a file 

 
AIM : Displaying the properties for a file or folder 

Procedure: 

Step 1: Press Click Start    +  Button.   

Step 2: To view information about a file or folder, Right-click it and select Properties.  

Step 3: The fastest way to you can also select the file and press key Alt+ Enter. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

 

The file properties window shows you information like the type of file, the size of the file, and when you last 

modified it. , Parent Folder, Free Space, Accessed. 
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AIM : Using cut and paste operations to move a file 

Procedure: 

Step 1: Press Click Start    +  Button.   

Step 2: To cut file or folder Select then Right-click it and select Cut. 

Step 3: The fastest way to you can also select the file and press key  

 

Step 4: Right-click a blank area on the file Explore, Select Paste. 

Step 5: The fastest way to you can also select the file and press key  

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

(Cut)  (Paste)  
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AIM : Using copy and paste operations to copy a file 

Procedure: 

Step 1: Press Click Start    +  Button.   

Step 2: To Copy file or folder Select then Right-click it and select Copy. 

Step 3: The fastest way to you can also select the file and press key +  

 

Step 4: Right-click a blank area on the file Explore, Select Paste. 

Step 5: The fastest way to you can also select the file and press key +  

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

(Copy)     (Paste)  
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Ex No: 6 Date:   

a) Moving and copying files with mouse 
b) Searching a file or folder by using search command 
c) Recognizing File types using icons 

 
AIM : Moving and copying files with mouse 

Procedure: 

Step 1: Step 1: Press Click Start    + Button.   

Step 2: To Copy file or folder Select then left-click and HOLD. (Copy) 

Step 3: You release the left mouse button the file will be moved to the new location where you 

released the mouse button. (Paste) 

Step 4: To Copy file or folder Select then Right-click and HOLD. 

Step 5: Select copy here then new location move here 

 

Result:  

The program was Executed Successfully and output is verified. 

Output: 

Select File or Folder Right Click Mouse Select Copy new location Right Click Mouse Select Paste. 
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AIM : Searching a file or folder by using search command 

Procedure: 

Step 1: Press Click Start  +  Button.  

Step 2 : Select Search Local Drive Like C:\  D:\ E:\ This PC to look in all devices or Folder  

 

Step 3: Right Corner show Search Quick access  

Step 4: Enter Search Key word “COA” after Press Enter or Click  

 

Output: 
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Aim : Recognizing File types using icons 

Procedure: 

Step 1: Press Click Start    +  Button.   

Sort by Arrange Icons 

Step 2: Right-click a blank area on the file Explore, Select Sort by 

Step 3: Select an option, such as name, Date, Size, Type, Date modified, and Dimensions. 

Step 4: The available options vary depending on the selected folder type. 

Ascending. Select to sort items in ascending order A-Z. 

Descending. Select to sort items in descending order Z-A. 

 

Group by Arrange icons 
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Step 1: Right-click a blank area on the file Explore, Select Group by 

Step 2: Select an option, such as Name, Date, Size, Type, Date modified. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

The File Explore, Select Group by Arrange icons by Name, Type, Size or Date modified click 

Arrange Icons. (Start    +    View Group by) 
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Ex No: 7 Date:   

a) Recording and saving an audio file 
b) Connecting a printer to the PC 
c) Capturing and saving entire monitor screen & active program window as images 

 
AIM :  Recording and saving an audio file 

Procedure: 

Step 1: Press Click Start     Button 

Step 2:  Type search bar in the bottom-left corner of the Windows 10 screen 

Step 3:  Type “Voice Recorder” 

Step 4:  Click on “Voice Recorder” 

 

Step 5: Press key Ctrl + R  Recording will be Start. 

Step 6: Start speaking  

Step 7: Press key Backspace Key Record will be Stop then file will save automatically. 

Result:  

The program was Executed Successfully and output is verified. 
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Output:  

Ctrl + R  Recording Start            

Backspace Key  Recording Stop  

Recoding Save Automatically         
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AIM : Connecting a printer to the PC 

Procedure: 

Step 1: Press Click Start     Button 

Step 2:  Type search bar in the bottom-left corner of the Windows 10 screen 

Step 3:  Type “Devices and Printers” 

Step 4:  Click on “Printer & Scanners” 
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Step 5:  Connect Printer to computer and Power ON.  

Step 6:  Click on Add a printer or Scanner 

Step 7: Wait for it to find nearby printers, then choose the one you want to use, and select Add 

device. 

Result:  

The program was Executed Successfully and output is verified. 

Output:  
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AIM : Capturing and saving entire monitor screen & active program window as images 

Procedure: 

Step 1:  The PRINT SCREEN key is usually located in the upper right corner of your keyboard. The 

key looks similar to the following:  

Step 2:  The text you see on your keyboard might be PrtSc, PrtScn, or PrntScrn. The other text on the 

Print Screen key is usually SysRq. 

Copy only the image of the active window 

The active window is the window that you are currently working in. Only one window can be active 

at a time. 

Step 3: Click the window that you want to copy. 

Step 4: Press ALT+PRINT SCREEN. 

Step 5: Paste (CTRL+V) the image into an Office program or other application. 

Copy the entire image on the screen 

Step 6: Open everything you want to copy and position it the way you want. 

Step 7: Press PRINT SCREEN. (If you Used Laptop then Fun or Start + PrtSC) 

Step 8: Paste (CTRL+V) the image into an Office program or other application 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

 

Alt + PrtSc – Copy Active window   
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MS OFFICE: MS-WORD 

& 

OPEN OFFICE: WRITER 
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Ex No:8 Date:  
Preparing a Govt. Order / Official Letter / Business Letter / Circular Letter- Covering formatting 
commands - font size and styles - bold, underline, upper case, lower case, superscript, subscript, 
indenting paragraphs, spacing between lines and characters, tab settings etc. 
 
AIM : Preparing a Govt. Order / Official Letter / Business Letter / Circular Letter- Covering 
formatting commands - font size and styles - bold, underline, upper case, lower case, superscript, 
subscript, indenting paragraphs, spacing between lines and characters, tab settings etc. 
 
Procedure: 

Step 1 : Press Keys Start    +   

Step 2 : In the box type winword  OK  

 

Step 3 : Type letter and Formatting below 

Step 4:  Press Shortcut Ctrl + D  Show Font Properties. 

Step 5:  Change font size  and styles - bold, underline, upper case, lower case, superscript, subscript. 

 

Shortcut  

 Font size Change - Ctrl + ] (font size increase) or Ctrl+[ (font size decrease) 

 Font Bold – Ctrl +B 

 Font Underline – Ctrl + U 

 Upper Case – Ctrl + Shift + A 

 Capitalize Each Word, select the text and press SHIFT + F3 
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 Superscript – Ctrl + Shift + + 

 Subscript - Ctrl + = 

Step 6: Go to Home > Change case  . 

Do one of the following: 

 Sentence case. 

 lowercase. 

 UPPERCASE. 

 Capitalize Each Word. 

 Capitalize Each Word and the opposite,  

 cAPITALIZE eACH wORD 

Step 7:  

Indenting paragraphs, spacing between lines 

 

Step 8:  Press Shortcut Ctrl + D Show Font Properties. 
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Step 9: Need spacing between characters Ctrl + D Show Advanced Properties 

 

Step 10: Line Spacing Shortcut  

 Single Line spaced Ctrl +1 

 Apply 1.5-line spacing to the paragraph. Ctrl+5.  

 Double Line -spaced  Ctrl +2  

 Add or remove space before the paragraph. Ctrl+0 (zero). 
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Step 11: Tab Settings. 

 

Result:  

The program was Executed Successfully and output is verified. 

Output:  

M. VEERAPANDIYAN, MBA., Telephone : 2688545 
CAD Designer  14 Annala Salai, 
 Puducherry 605 5501. 

 10th May 2022. 

The Collector of Villupuram, 
Villupuram. 

Sir, 

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of 
your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other 
document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your 
current document look. 

You can easily change the formatting of selected text in the document text by choosing a look for the 
selected text from the Quick Styles gallery on the Home tab.  To change the overall look of your document, 
choose new Theme elements on the Page Layout tab. To change the looks available in the Quick Style gallery, 
use the Change Current Quick Style Set command.  
 
Yours Faithfully, 
(M. VEERAPANDIYAN) 

Copy to 

The Tahslidar, Villupuram  


